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Introduction

One of Tabs3 Billing's most powerful features is the flexibility to customize how your statements look
when generated for each client. Configuration of the statement format occurs at various levels.
These levels include the following:

Tabs3 Billing Customization page 1
Statement Customization page 3
Statement Printer Setup page 7
Statement Template page 8
Email Template page 14
Client Setup page 19
Statement Notes page 22
Statement Designer page 28
Bitmaps page 31
Trust Accounting Software page 33

Purpose of Guide

The Tabs3 Billing Statement Formatting Guide covers the various options for customizing your billing
statement to look the way you want it to look. It includes information on mailing and emailing
statements, designing the statement layout, changing the way information is formatted, and more.

A separate Statements Guide includes information for how to generate statements. Additional
guides for other software features are also available on our Web site at:

Tabs3.com/support/docs.html

Tabs3 Billing Customization

The first level of defining the statement format can be found in Tabs3 Billing Customization. These
options are firm-wide and affect all clients.

Setting Up Tabs3 Billing Customization

Menu: Utilities | Customization
Home: All Actions | Setup | Customization

The Customization tabs we will be looking at include the Main tab, Options tab, Rates tab, and
Client Defaults tab.
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Customization ==

Customization

=5

Main  Other Systems Options Rates  Client Defaults Merchant Services Main  Other Systems Options Rates  Client Defaults Merchant Services

Key Type: | Numeric

2 Aging Periods

ot periods: | 3| period period period
First Month of Reparting Vear: | January ~
Profession Customization Period 4: Periad 5:
Client Label: | CLIENT Timekeeper Label: | TIMEKEEPER
Timer Options
Verification Lists Statement Numbering: | Firm Level v
[ create List for Fees [create List for Costs

reate List for Payments [create List for Client Funds Client Funds

Allow deletion of verification lists without printing Automatic Payment Tcodes: Fee:

1~
et Sttemets Mithod e T .

Outlook
Ooutoo Finclude fund balance on statements for clients with only a fund balance
@ smTP
[linclude clients with only a fund balance on WIP reports  Billing Increment: l:l
Figure 1, Customization - Main tab Figure 2, Customization - Options tab
Customization =1 Customization
Main  Other Systems Options Rates  Client Defaults Merchant Services Main  Other Systems Options Rates  Client Defaults wierchant Services
Sales Tax
[JProgress Billing [Receipt Allocation by Invoice
[ Tax services [ 7ax Expenses [7ax Advances
P 7 Release To Bill [CINon-billable
[IBill On Demand [ Task Based Billing Client

[Jchange Discount Type to None after statement updated

Method to Apply

1 - Oldest Advs, Oldest Exps, Oldest Fees, Oldest FinChg ~
Payments:
Finance Charge Trust Integration: | Detail ~ Statement Delivery Method: | Mail ~
& .
I assess Finance Charge Minimum Amount; Cover Statement:  Detail v [ Combine Matters
Subject to Finance Charge 8ill Minimum Amount
Ll subj 9 o Fund Application:  Manual &

Rate 1: Rate 2:

Rate = Soes o

Fee: 0-Nontaxable ¥ Exp: 0-Nontaxable ¥ Adv: 0 - Nontaxable v

Finance Charge

[ Assess Finance Charge 1-12.00%
] Last
Figure 3, Customization - Rates tab Figure 4, Customization - Client Defaults tab
Main tab The Main tab allows you to select whether email

statements will be sent via Microsoft® Outlook® or an
SMTP server.

Options tab The Options tab allows you to define your aging periods
and also allows you to specify if statement numbering will
be implemented at the firm level or the client level.
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Rates tab The Rates tab includes information regarding sales tax and
finance charge.

« You can specify if you want sales tax charged for
fees, expenses, or advances. Up to nine different
sales tax rates can be defined. The sales tax feature
in Tabs3 Billing is very sophisticated, allowing you
to specify whether or not individual transactions
will be taxed.

« The Rates tab can also be used to define whether
you want a finance charge assessed, if the finance
charge is subject to a finance charge, and if you
want to assess a minimum finance charge. Up to
five different finance charge rates can be defined.

Client Defaults tab The Client Defaults tab allows you to select the default
settings for new clients.

Statement Customization

The next level of defining the statement format can be found in Statement Customization. Statement
Customization allows you to define many additional firm-wide statement formatting options.

Setting Up Statement Customization

Menu: Statements | Statement Setup | Customization

Home: All Actions | Statements | Statement Setup | Statement Customization
Statement Customization includes the following tabs:

« Options

« Terminology
« Headings

» Cover Stmt
« Months
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=

{8 Statement Customization

Statement Customization

Options  Terminology Headings Cover Stmt Months

Previous Balance Position: Top of the Statement

Print Non-billable Hours: No

Courtesy Discount Position: After the last fee transaction

Blank lines between combine statements (0-9, P)

[JDouble space between each fee transaction
Double space fees for Summary Fee Format
[Jprint credits on invoice format statements
[Iprint finance charge on invoice format statements
Print blank miscellaneous lines

[ 5pell statement date on statements

(4 Add Current work to Past Due Amounts

[ Combine &l Totals on Statement

[Jprint Billable Amounts of Zero

Options Terminology Headings Cover Stmt Months

Line 1: |A((mmt No:

Line Text

DRAFT STATEMENT
Previous Balance before Adjustments
Previous Balance

Hours

Bate

n/c

Fees

Courtesy Discount

Met Fees after Courtesy Discount
For Curtent Services Rendered

Sales Tax nn Samines

10
11
12
12

v
Description: Press F2 to Edit
Line 1 (Account Noi) is the label printed before the client number on all pages of a
statement. If only an "*" is entered in the first character position of this line, the client
number will not print on the statement.

Figure 5, Statement Customization
Options tab

Figure 6, Statement Customization
Terminology tab

=

Statement Customization

Statement Customization

Options Terminology Headings Cover Stmt Months

Lines of text to be printed as a heading on the first page of each billing statement:

‘Jensen, Martin & Anderson, P.C.

‘1621 Cushman Drive

‘me\m NE 68512

\(492) 419-2200

Lines of text to be printed as a message at the end of each billing statement:

This statement includes all payments received through the last day of the previous
manth.

Options Terminology Headings Cover Stmt wonths

Cover Statement Headings

Line 1: |

Line 2: |

Line 3: |Prewnus Balance

Line 4: |Faes

Line 5: |Expenses

Line 6: |Ad\'ances

Line 7: |Pa5'ments

Line 8: |Fmanre Charge

Line 9: |Ba|ance

Print Client Account IDs on the Cover Statement

Figure 7, Statement Customization
Headings tab

Figure 8, Statement Customization
Cover Stmt tab
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Options tab

Statement Customization

[E=8 E=R T

Options  Terminology Headings Cover Stmt Months
Statement Month Mames
Month 1: January
Month 2; February
Month 3: March

Month 4: April

Month 5:

=
&

Month 6: June
Month 7: July
Month 8: August
Month & September
Month 10: October
Month 11: November

Month 12 December

Figure 9, Statement Customization

Months tab

The Options tab allows you to specify if you want the
previous balance line to print at the beginning of the
statement or after fees and costs, whether you want non-
billable hours to print, and where you want the Courtesy
Discount to print. You can specify a number of blank lines
or a page break between combined statements, whether
you want fees double spaced, and if you want credits
included on invoice format statements. You can specify if
you want finance charges on invoice format statements
and whether you want blank miscellaneous lines printed.
You can specify whether you want the statement date to
be printed in MM/DD/YYYY format or spelled out. You can
specify whether current work will be included in past due
amounts and if you want a combined total of all due
amounts on a statement. You can specify whether you
want “0.00” to print for billable transactions with zero
amounts or not print an amount at all.

-5
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Terminology tab

Headings tab

Cover Stmt tab

Months tab

The Terminology tab contains modifiable statement
terminology. There are over 70 different areas of statement
terminology that can be modified. For example, if you
don't like the terminology “Balance Due,” you can change
it to whatever you like, such as “Total Amount Due.” Or, as
another example, you can change the “For Current
Services Rendered” line to read "Professional Services.” If
desired, you can print optional headings for the fee,
expense, advance, and payment sections of the statement.
Tabs3 Billing also allows you to embed the statement date
or cut-off dates in many of the statement terms. You can
also apply bold, italic, and underline attributes to the
statement terminology. You can configure Tabs3 Billing so
the expenses and advances combine into one section on
the statement. You can specify if the client’s account
number, the statement number, the page number, or the
term “Continued” will print on statements. You can specify
if you want the contact name to print before the client
name.

The Headings tab allows you to enter up to nine lines of
text for your firm’s name and address, thus allowing you
to use plain paper instead of pre-printed letterhead for
your statements. These nine lines can alternatively be used
to insert any type of global notes that you want printed at
the top of every statement. You can also enter up to four
lines of optional text that prints at the end of each
statement. Many firms use these lines for a message
regarding finance charge policy, payment terms, or
perhaps a seasonal message. Alternatively, you can use a
bitmap image file for the statement heading or you can
create a custom heading and statement notes using the
Statement Designer.

The Cover Stmt tab allows you to customize cover
statement terminology and specify whether you want
Client IDs included on the cover statement.

The Months tab contains the names of the twelve months
of the year. These names are used if you customized Tabs3
Billing to spell out the statement date.
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Training Videos

You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

u Customizing Statements Video (Statement Customization Segment)

Printer Setup

The next level of defining the statement format can be found in the Tabs3 Billing Statement Printer
Setup.

Statement Printer Setup

Menu: File | Print Setup | Statement Setup button
Home: All Actions | Setup | Print Setup | Statement Setup button

You can use any Windows printer to generate statements. You can specify the font you want used,
the paper size and source, and whether you want envelopes printed with statements. If you plan on
using the nine lines specified in Customization for the statement heading, you can specify a heading
font. As an alternative, you can include a bitmap of your firm's letterhead allowing you greater
formatting flexibility. If you will be using the custom page layouts created by the Statement Designer
(page 28), you must select the Enable Statement Designer Layouts check box as shown in Figure 10.



http://www.tabs3.com/trainingvideo/v18/t3video.html
http://www.tabs3.com/t3stmtcustvideo
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Statement Setup for Brother HL-2270DW X
MNormal Font: 10 pt Segoe UI Select [ print Envelopes
Statement Width

Enable Statement Designer Layouts
® Automatic: m Percent Adjustment < g

O Fixed: 0 Columns
Page One
Heading Font: 10 pt Segoe Ul Select
Paper; Letter ~ Source; Auto Select ~
Blank Lines at Page Top: El Elank Lines Befare Detail: [[] Compress Address
eitmap Select...
0.000 Flush Left Margin
Continuation Page
Paper: Letter ~ Source; Auto Select ~
Blank Lines Before Detail:
Envelopes
Letter Auto Select
0.000 0.000
Portrait Landscape
oK Cancel Help

Figure 10, Print Setup - Statement Setup

Statement Templates

The next level of defining the statement format can be found in the Statement Templates window.
Statement templates determine many options pertaining to the format of the billing statement.

Defining Statement Templates

Menu: Statements | Statement Setup | Statement Templates
Home: All Actions | Statements | Statement Setup | Statement Templates

Each statement template includes the following tabs:

o General

o Fee Format

« Cost/Payment Format
« Layouts




Statement Formatting Guide

[ Statement Templates =N ECR =] Statement Templates ==

General Fee Format Cost/Payment Format Layouts General Fee Format Cost/Payment Format Layouts
Template ID: v Description: | detail format including timekeeper recap ‘ Template 1D: v detail format including timekeeper recap
Statement Type Fee Format Include
@ Statement Format O Invaice Format Date Hours: Totals Only N
® standard
[ Timekeeper Initials Amount: Subtotals & Totals v
Billing History: | Include History ~ | Past Due Message: Aged &7 Oinfo Only
[ Description Paragraph: |Date/Timekeeper
Statement Notes O summary

ONoF [rate Subtotal: | Date v
Beginning Note: ¥ Payments received after \S are not included an o Fees

A Total for Non-billable Hours
Ending Mote: ~  Afinance charge of 1% per month will be asse:

Fee Recap Include
Include Statement Notes for each File on Combined Statements @ Timekeeper FHours Level Deseription
Include Statement Notes on a Cover Statement O Timekeeper Level FTotal
ORate )

Print Statement Comments on Draft Statements Rate: |Average Hourly -

O No Recap
[l Allow Page Break in Transaction Descriptions
[Juse as Draft Statement Default for New Clients
[JUse as Final Statement Default for New Clients

Figure 11, Statement Templates Figure 12, Statement Templates
General tab Fee Format tab
¥ statement Templates == Statement Templates ===
General Fee Format Cost/Payment Format |ayouts General Fee Format Cost/Payment Format Layouts
Template ID: v detail format including timekeeper recap Template ID: v detal format induding timekeeper recap

Expense Format Advance Format Page Layouts
@® Standard @® Standard Page 1: ‘ Sample Layouts | Letterhead V‘
O Teode Detail with Subtotal O Teode Detail with Subtotal Pagez: | -]
(O Teode Subtotal Only O Teode Subtotal Gnly Envelope: ‘ v‘
O summary O summary Cover: ‘ v‘
O No Expenses O No Advances

MNote: In order to utilize layouts created in the Statement Designer, the Statement
Payment Format Printer Setup window must have the "Enable Statement Designer Layouts" check box

selected.
® Detail
O Totals Only
O Total By Date

Figure 13, Statement Templates Figure 14, Statement Templates

Cost/Payment Format tab Layouts tab

General tab The General tab is used to specify invoice or statement
formatting, billing history options, past due messages and
statement notes.
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Fee Format tab The Fee Format tab is used to determine whether fees
print and, if so, whether timekeeper initials, dates, hours,
hourly rates, and amounts are included. Subtotaling of
fees is defined here. An optional fee recap by timekeeper,
timekeeper level, or rate can also be set up. The recap can
include hours, timekeeper levels, rates, and a total amount.

Cost/Payment Format tab The Cost/Payment Format tab is used to specify whether
expenses and advances print and, if so, the format used on
the statement. You can also indicate whether payments
will be shown in detail, be subtotaled by date, or show
totals only.

Layouts tab The Layouts tab is optional and is used to designate which
custom Page Layouts created by the Statement Designer
will be used when statements are printed for clients that
are assigned this template.

These options apply to all clients who are assigned the specified template. Each client is assigned
two statement templates—one for draft statements and one for final statements. Once a template
has been defined, any changes made to a statement template affect all clients who are assigned that
template. Some firms will have separate statement templates for each timekeeper.

There is no limit to the number of statement templates that can be defined.

Typically, firms will set up a few statement templates to use before they begin to add clients. As
clients are added, they are assigned statement templates on the Statement Options tab of the Client
file. Once statement templates have been set up and fine-tuned, the Statement Templates program is
typically used only when changes or a new template is required.

Client Information - Williams/John 1

L}
Address Setup Rates AJR & Fund Balances Client Notes

Billing Preferences Statement Options Split

Client ID: 101.00 ¥ Williams/John 7
Lol 220 TN \Aw et 1

Statement Format 4
¢

F

1

Trust Integration: | Summary ks Cover Statement; | Detail ~

_—

T P A e adeam— P R ey SR ,)

Figure 15, Statement Format Options

-10-
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Adding a New Statement Template

You can add a new statement template based on default system settings.

» To add a statement template

1.

From the Statements menu, select Statement Setup icon, and then click Statement
Templates.

On the General tab, enter a new Template ID.
Enter the Description.

Select the desired options on the General, Fee Format, Cost/Payment Format, and Layouts
tabs.

Click B to save the new template.

Copying a Statement Template

You can copy an existing Statement Template and then make changes as needed.

> To copy a statement template

1.

AR R A

From the Statements menu, select Statement Setup icon, and then click Statement
Templates.

On the General tab, select the Template ID you want to use as a basis for the new template.
Change the Template ID to the name of the new statement template.
In the Description field, enter a description for the new template.

Make the desired changes.

Click B to save the new template.

Changing the Statement Template Used
When changing the statement template that is used, it can be changed either individually for each
client, for multiple clients at one time, or when running specific statements.

Changing the Statement Template for One Client

You can change the Draft Template and/or Final Template via the Client file on an individual basis.

11 -
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» To change the statement template used for a single client

From the File menu, select Open icon, and then click Client.
Select the Client ID for which you want to change templates.

From the Statement Options tab, in the Statement Format section, select the desired Draft
Template and/or Final Template.

Click E to save the changes to the client.

Changing the Statement Template for Multiple Clients
If you want to change statement templates for multiple clients, you can use the Change Client
Options program.

» To change the statement template used for multiple clients

1.

S O o

From the Maintenance menu, select Client Related icon, and then click Change Client
Options.

Select the Client ID range, or click Multiple to select multiple ranges of clients.

From the Statements tab, click the Select button.

Select Draft Template and/or Final Template and click OK.

In the Statement Format section, select the desired Draft Template and/or Final Template.

Click OK.

Change Client Options

{

Client Setup Rates Billing Statements {
Statement Format ‘1
Draft Template: v Final Template: v "

]

T— j T— i

Detail Detail 1

T RN S — P B e, ,._-.,

Figure 16, Change Client Options

Changing the Statement Template for One Statement
If you want to change the statement template temporarily, or test how it will look, you can select a
template when generating statements.

-12-
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» To change the template used at the time statements are generated

1. From the Statements menu, click Generate Statements.

2. Select the Client ID range, or click Multiple to select multiple ranges of clients.

w

From the Options tab, in the Statement Options section, click the Statement Template
button.

In the Statement Template Options window, click the Select Template button.
In the Template ID field, select the desired Template ID and click OK.

Click OK to close the Statement Template Options window.

N o oA

Generate the statement as normal.

Statement Options

Statement Date: 05/11/2018 | +

g Beginning Statement Mumber: 7631

Last Mumbers Used: 7630 thru 7630

( Statement Template )
1

Email Template

Figure 17, Generate Statements Program

After closing the Generate Statements window, the next time you run statements, the template
selected in the Client file will be used unless a template has been defined and saved in a report
definition.

Training Videos
You can view the following training video for more information. Clicking the image will open the

training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

u Customizing Statements Video (Statement Templates Segment)

13-
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Email Templates

The next level of defining the statement format can be found in the Email Templates window. Email
templates are used by clients who are set up to receive statements via email. Email template options
apply to all clients who are assigned the specified template. Once a template has been defined, any
changes made to the email template affect all clients who are assigned that template. Some firms will
have separate email templates for each timekeeper, category, or billing frequency. If desired, email
templates can also be defined for specific clients.

Setting Up Email Templates

Menu: Statements | Statement Setup | Email Templates
Home: All Actions | Statements | Statement Setup | Email Templates

Each email template must have valid Email Identification information defined in the From Name,
From Address, and Reply To Address fields. When sending via Microsoft Outlook, the Reply To
Address is unavailable and instead is controlled by Outlook. Additional recipients can also be
defined, including entering a firm email address in the Bcc Recipients field to ensure that a copy of
the sent email statement is retained in a single account’s email messages. The Subject and Body of
the email message can be defined using variables from the Available Fields list. Using variables in
place of text allows email statement messages to easily be customized for each individual client or
matter that is set up to receive statements via email. Additionally, when the cursor is in the Body
field, the Email Template Toolbar is available to format text.

You can include a variable for a ProPay payment link in your email message, which allows clients to
pay their bill online with a credit card, debit card, or eCheck. See Knowledge Base Article R11767,
“Using the Tabs3 Payment Link,” for more information.

There is no limit to the number of email templates that can be defined.

-14-
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[ Email Templates [E=8EER=

Template ID: | OnlinePayment2 Description: | Online Payment - 'Click Here' Lmld ‘

[Juse as default Email Template for new Bill To records

Email Identification

From Name: ‘ Michael L. Jensen ‘

From Address: ‘ mjensen@jensenlaw.com ‘

Reply To Address: ‘ admin@jensenlaw.com ‘

Additional Recipients

Cc Recipients: ‘ ‘

Bcc Recipients: ‘ admin@jensenlaw.com ‘

Email Message

Available Fields: Subject:
Adobe Reader Link ~ ‘Ycur statement from =Firm Name=
Balance Due Body:

Beginning Statement Notes
Bill To Address

Bill To Attention Line

Bill To Full Name

«Bill To Full Name», ~

Your current statement dated «Statement Date» 1s attached.

Billing Notes and Instructions «Online Payment Begin Text»We now accept secure online payments
Client Address wia ProPay. To make a secure online payment, «Online Payment "Click
Client Attention Line Here"».«Online Payment End Text»
Client Full Name v ~

Sincerely,
< >

P ¢ Timek N
e «Primary Timekeeper Name» v

«Firm Name»

Figure 18, Email Templates

Typically, firms will set up a generic email template before they begin to add clients. As clients who
will receive email statements are added, email templates are assigned in the Bill To Record window,
which is accessed via the Billing Preferences tab of the Client file. Once email templates have been
set up and fine-tuned, the Email Templates program is typically used only when a change or a new
template is required.

-15-
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Bill To Record

Bill To Mame: | Larson/Michael

Description: |Address shown on the Address tab

Staternent Delivery Options
[ Mail Statement
[ Email Statement
Print the Client's Name and Address on the Statement

Print the Bill To's Name and Address on the Statement

Staterment Address

Business* 123 Washington St.
Lincoln NE 68508

M Include Attention line on statement
(® Matter's Contact Name: Michael Larson
O other:

1

Email Delivery Options

Email 1* | mlarson@larson.com

Email Template: | OnlineExample ¥  Online Payment
J/
Cancel Delete

PP ] = P T S U TSI TITIITLY TR S PR (R ) R ey

Figure 19, Bill To Record Window

More Info: Additional information on Email Templates can be found in Tabs3 Billing Help and in
Knowledge Base Article R11338, “Emailing Tabs3 Statements.”

Adding a New Email Template

You can create a new email template from scratch.

» To add a new email template

1. From the Statements menu, select Statement Setup, and then click Email Templates.
2. Enter a new Template ID.

3. Enter the Description.

-16-
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4. Enter the desired information for the email template.

5. Click B to save the new template.

Copying an Email Template

You can copy an existing email template and then make changes as needed.

» To copy an email template

1. From the Statements menu, select Statement Setup, and then click Email Templates.
Enter the Template ID you want to use as a basis for the new template.

Press Esc.

Change the Template ID to the name of the new email template.

Enter the Description.

S vk W

Make the desired changes.

7. Click B to save the new template.

Changing the Email Template Used
When changing the email template used, it can be changed either individually for each client, for
multiple clients at one time, or for a specific statement run.

Changing the Email Template for One Client

You can change the email template via the Client file on an individual basis.

» To change the email template used for a single client

1. From the File menu, select Open, and then click Client.
2. Select the Client ID.

3. From the Billing Preferences tab, in the Statement Delivery Options section, select the Bill
To Name for which you want to change the email template.

4. Click the Edit button.
5. Select the Email Template you want to use.
6. Click OK.

7. Click B to save the changes to the client.

-17-
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Changing the Email Template for Multiple Clients
If you want to change email templates for multiple clients, you can use the Change Client Options
program.

» To change the email template used for multiple clients

1.

o vk~ W

From the Maintenance menu, select Client Related, and then click Change Client Options.
Select the Client ID range, or click Multiple to select multiple ranges of clients.

From the Billing tab, click the Select button.

Select Email Template and click OK.

In the Statement Delivery Options section, select the desired Email Template.

Click OK.

Note: Changing the Email Template using the Change Client Options program will change the
template for all Bill To records associated with the selected client(s).

Changing the Email Template for One Statement
If you want to change the email template temporarily, or test how it will look, you can select a
template when generating statements.

» To change the email template used at the time statements are generated

1.
2.
3.

From the Statements menu, click Generate Statements.
Select the Client ID range, or click Multiple to select multiple ranges of clients.

From the Options tab, in the Statement Type section, select Final. Final must be selected
before an email template can be selected.

In the Statement Options section, click the Email Template button.
In the Select Email Template window, select the desired Template ID and click OK.

Generate the statement as normal.

After closing the Generate Statements window, the next time you run statements, the template
selected in the Client file will be used unless a template has been defined and saved in a report
definition.

-18-




Statement Formatting Guide

Training Videos

You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |

Training Videos menu and at Tabs3.com/t3video.

u Emailing Statements Video

u Getting Paid Using Online Payments Video

Client Setup

The next level of defining the statement format can be found in the Client file. These options are

specific to the individual client.

Setting up the Client

Menu: File | Open | Client
Home: All Actions | People | Client

The Client tabs we will be looking at include the Setup tab, A/R & Fund Balances tab, Billing
Options tab, Billing Preferences tab, and Statement Options tab.

[ Client Information - White/Kelly

[ Client Information - White/Kelly

Billing Frequency: | Monthly v
Repart Order Timekeepers Status
-
secondary. [T | v
Originating: -

Payment Settings

Monthly Clients

Primary: Kendra I. Michaels

[INon-billable
Michael L. Jensen

Robert 0. Burns

Method to Apply Payments: 2 - All (Oldest Finchg, Oldest Advs, Oldest Exps), All Fees
Receipt Allocation by Invaice

%'s Defined

[ Task Based Billing Client

Fee Compensation Rules

Balance Due:

Progress Billed: 0.00

Last Statement Date: !

Last Payment Date:

Last Statement #: 525

Additional A/R Info

Client Funds
Fund Balance: e

Fund Application: | Manual

ek s o b s bbb, bt s M e i Ak i i e

Progress Billed Tax:

Unapplied Payments:

Last Payment Amount: 125.00

Trust Account Balances

Statement Format; | Detail ~

[Jone Time Retainer

]
1
gilling Preferences Statement Options split Billing gilling Preferences Statement Options g f
Address Setup Rates A/R & Fund Balances Client Notes [« Address Setup Rates A/R & Fund Balances Client Notes C;
Client 1p: 85000 ,  White/Kelly Client 1p: 85000 ,  White/Kelly
Divorce Divorce
Settings Feas Expensas Advances Fin. Charge
Billing Category: v Family Law Amount Due:* 0.00 0.00 0.00

e e o g ek e o S, e B s

Figure 20, Client - Setup tab

Figure 21, Client - A/R & Fund Balances tab
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{8 Client Information - White/Kelly + | [ Client Informeation - White/Kelly 3
1
Billing Preferences Statement Options split E\'H\'ng? Address Setup Rates A/R 8 Fund Balances Client Notes C(
Address Setup Rates A/R & Fund Balances Client Notes. o gilling Preferences Statement Options. split B\'H\'ngi
Medical Care of Brianne Divorce b
Threshold Billing Items i Billing Status ]
4 L}
@ Bill individual item i its threshold is met Fee: g HRelease To sil [Jgill On Demand Progress sillng i
Osill all items if any threshold is met Exp: 0.00 | {
4[| siling Motes }
Oill all items if Total threshald is met Adv: 0.00 &
1 Instructions 1
Courtesy Discount i f
Discount Type: | Nene ~ Arnount; 0.00 ) i
Change Discount Type to None after statement updated Ji i
i 3
Sales Tax { 1
Fee: 0= Exp: [0 Adv: |0 - Nontaxable
3 statement Delivery Options
Finance Charge 11 Bill To Name Description Mail  Email ~ P i
[ Assess Finance Charge Rate: |1 -12.00% i i
F . edit i
Days (0-999): 0 Apply Payment to Finance Charge: |First ! {
] [use a password to protect PDF statements when emailed: 1
‘ 1
< 4
3 !
E 3

Figure 22, Client - Billing Options tab

Figure 23, Client - Billing Preferences tab

[ Client Information - White/Kelly

Address Setup
Billing Preferences

Rates

Client ID:

Statement Format

Trust Integration: | Detail

Statement Notes

850.00 v

AR & Fund Balances
Statement Options

Client Notes Ci
split Billing

BTSN S

White/Kelly
Divorce

Final Template: v [ Col

“IMa

Pre= RPN

Cover Statement: | Detail ~

Beginning
Statement
Motes:

Ending
Statement
Motes:

Change Notes to blank after statement updated: []8eginning [ending

e M i M i, hb P M, Aty 5 i,

Figure 24, Client - Statement Options tab
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Setup tab The Setup tab of the Client file includes the billing
frequency for defining client batches and the method to
apply payments.

A/R & Fund Balances tab The A/R & Fund Balances tab allows you to specify how

client funds are applied, whether there is a minimum
and/or target balance, and how funds are displayed on a
client’s statement.

Billing Options tab The Billing Options tab allows you to specify billing to
occur when thresholds are met, whether to apply a
courtesy discount, sales tax rates, and finance charge
options.

Billing Preferences tab The Billing Preferences tab allows you to specify whether
the client will receive statements via mail, email, or both. It
also allows you to specify an additional Bill To contact to
use when a client is to receive a duplicate statement or
when a client’s statement is to be sent to a third party.

Statement Options tab The Statement Options tab is used to designate the draft
and final statement templates that will be used for this
client and includes an option to combine matters on
statements, cover statement options, and trust integration
information. This tab also contains Beginning and Ending
Statement Notes that allow optional unique statement
notes for the client to print at the beginning and end of
the client's statement if desired.

Training Videos

You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

n Client Overview Video
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Statement Notes

There are several different levels of statement notes that can be printed on a statement including
notes individual to the client, notes printed for clients using a specific statement template, and notes
that appear on all clients’ statements. All levels or any combination thereof can be used on a client's
statement.

Implementing Statement Notes

You can define notes that will be displayed on your clients’ statements via the following areas:

« Client Statement Notes

» Statement Notes program

» Statement Customization program
« Miscellaneous Lines

Client Statement Notes

Beginning and Ending Statement Notes of up to 250 characters each can be added for any client.
These notes are unique to the specific client. An example of Client Beginning and Ending Statement
Notes can be seen in Figure 25.

» To add Beginning and Ending Statement Notes for a client

1. From the File menu, select Open, and then click Client.
2. Select the Client ID for which you want to add notes.

3. From the Statement Options tab, in the Statement Notes section, enter the Beginning
Statement Notes and/or Ending Statement Notes to be printed on the client’s statement.

4. Optionally Change Notes to blank after statement updated by selecting the Beginning
and/or Ending check box if you want the note to be printed on the next statement only.

5. Click B to save the changes to the client.
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Client Information - MegaConstruction p
Address Setup Rates AfR & Fund Balances Client Notes

Billing Preferences Statement Options split4

4

Client ID: 41500 v MegaConstruction Corparation J

Corporate Merger - Megabuilders and Builds 1

Statement Format f

Trust Integration: | Detail = Cover Statement: | Detail ~ 3

4

4

Statement Notes ;

Beginning \LDocket No: 94D-07965 {

Statement |\ OJIC File No: 983724-2334 1

Notes: 4

j.

!

4

4

Ending \C Reminder: Our next meeting is scheduled for Nov 28 at 2:30 p.m. 1

Statement 1

MNotes: b

1

ki

'

e

Change Motes to blank after statement updated: []Beginning []Ending ;

<

E

<

L

Figure 25, Client File

More Info: Additional information on client options can be found on page 19 of this guide and in
Tabs3 Billing Help.

Statement Notes Program

The Statement Notes program is used to create statement notes of up to 511 characters. Once
created, these notes can be assigned to a Statement Template. Statement Notes will then be used by
all clients who are assigned that statement template. An example of Client Beginning and Ending
Template Notes can be seen in Figure 25.

There is no limit to the number of statement notes that can be defined.

» To add a new Statement Note

1. From the Statements menu, select Statement Setup, and then click Statement Notes.
2. Enter a unique Note ID.

3. In the Note Text field, enter the information you want to have included in the note.

4. Click E to save the new note.
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E Statement Notes EI@
Note Text: A finance charge of 1% per month will be assessed on all accounts

past due 30 days.

Figure 26, Statement Notes

> To specify the Statement Notes used on a Statement Template

1. From the Statements menu, select Statement Setup, and then click Statement Templates.
2. On the General tab, select the desired Template ID.

3. In the Statement Notes section, select the desired Beginning Note and/or Ending Note.

4. Click E to save the template.

Statement Templates E@

General Fee Format Cost/Payment Format Layouts

Template 1D: v Description: | standard fee & cost format (no recap) |

Statement Type
(®) Statement Format O Invoice Format
Billing History: |Include History ~ Past Due Message: | Aged ~

Statement Motes

Beginning Mote: ¥ Payments received after \S are not included on
Ending Note: v Afinance charge of 1% per month will be asse:

Minclude Statement Notes for each File on Combined Statements

Mlinclude Statement Motes on a Cover Statement

Print Statement Comments on Draft Statements
M allow Page Break in Transaction Descriptions

Cluse as Draft Statement Default for Mew Clients

I use as Final Statement Default for Mew Clients

Figure 27, Statement Templates
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More Info: Additional information on the statement templates can be found on page 8 of this
guide and in Tabs3 Billing Help.

Statement Customization Program

The Statement Customization program provides a way to add nine lines of up to 60 characters each
to be printed as a heading for each billing statement, and a message of up to 250 characters to be
printed at the end of each billing statement. The text entered in Statement Customization is global,
and will print on all billing statements. An example of global heading and ending messages can be
seen in Figure 26.

> To add lines of text to a statement using Statement Customization

1.

From the Statements menu, select Statement Setup, and then click Statement
Customization.

From the Headings tab, enter Lines of text to be printed as a heading on the first page of
each billing statement.

Enter Lines of text to be printed as a message at the end of each billing statement.

From the Cover Stmt tab, enter text into Line 1 and Line 2 if you want text to be printed at
the top of cover statements.

Click E to save Statement Customization.

E Statement Customization E@

Options Terminology Headings Cover Stmt Months

Lines of text to be printed as a heading on the first page of each billing statement:

‘Jensen, Martin & Anderson, P.C.

‘1621 Cushman Drive

‘Lincoln, NE 68512

\(402) 419-2200

[

ines of text to be printed as a message at the end of each billing statement:

This statement includes all payments received through the last day of the previous
manth.

Figure 28, Statement Customization
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More Info: Additional information on the Statement Customization program can be found on
page 3 of this guide and in Tabs3 Billing Help.

Tip: Statement note text, regardless of where it is defined, can be formatted to include bold, italics,
and underline attributes; can be aligned to the left, right, or center; and can take advantage of
date codes to automatically use the statement date, beginning fee date, or ending fee date.

Miscellaneous Lines

Miscellaneous Lines 1 through 3 defined on the Custom Fields tab in the Client File are automatically
displayed on statements, as shown in Figure 26, and can be used to add additional information
about the matter. However, if using a Statement Designer Layout, these lines must manually be
added to the Statement Designer Layout.

[ Client Information - White/Kelly =R

Billing Preferences Statement Options Split Billing Budget
Address Setup Rates A/R & Fund Balances Client Motes Custom Fields Billing Options

Client 1D: 850.00 © thltE/Ke\ly
Divarce

Miscellaneous 1: |Wh|te vs. White ‘

Miscellaneous 2: | "Uncontested ‘

Miscellaneous 3: | ‘

e e O Y Y e VU P S —

Figure 29, Miscellaneous Lines

» To add Miscellaneous Lines to a Statement Designer Layout

1. From the Statements menu, select Statement Setup, and then click Statement Designer.
In the Layout Tree pane, select the desired layout.

In the Field Selection pane, expand the Client Fields folder.

> won

Click and drag Miscellaneous 1 to the location in the Page Layout pane where you want to
place the line.

5. Repeat step 4 for Miscellaneous Line 2 and 3.

6. Click E to save the layout.

More Info: Additional information on the Statement Designer program can be found on page 28
of this guide and in Tabs3 Billing Help.

Figure 30 is an example of where the various Statement Notes are printed on a statement:
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Jensen, Martin & Anderson, P.C.
Limcoln Building, Suite 201
1621 Cushman Drive

Lincoln, NE 68512
Global Heading |——

Statement includes fees and expenses
for the period of 10/01/2018 through 107212018

Jefferson Insurance Co.
American Charter Building
Sth and West '0" Streets
Lincoln NE 62510-8320

Automobile Accident

Insured: John G. Schnell . .

Palicy No: 387-2308528 } Miscellaneous Lines 1-3

Soc Sec Mo: 501-08-3487

Docket No: 04D-07T085 __'7| Client Beginning Statement Notes I
QUJIC File No: 883724-2334

FPayments received after 10/31/2018 are not included on this statement.

Previous Balance | Beginning Template Notes I

Fees

10M14/2018 MLJ Telephone conference with John G. Schnell. Discussed details of accident.

For Current Services Rendered

Expenses

101442018 Mileage to Omaha.
10M14/2018 Long distance telephone charges.

Total Expenses

Total Current Work

| Client Ending Statement Notes I

Balance Due

Reminder: Our next meeting is scheduled for Nov 28 at 2:30 p.m.
A finance charge of 1% per month will be assessed on all
Ending Template Notes —r accounts past due 30 days.
Payments are due 10 days from 10/31/2018.
y : : |
| Global Ending Message i We appreciate your business!

Figure 30, Statement Notes Locations

RNt i e T T Pt et S T A e AN P e R o et e,

Training Videos

You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

n Customizing Statements Video (Statement Customization Segment)
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Statement Designer

The next level of defining the statement format is the Statement Designer. The Statement Designer
program lets you create customized layouts for your statements that allow you to position images,
text, and data. You can control the placement of various fields from the Client and Bill To files, and
add customized text, images, and other layout elements to the statement. Once a page layout has

been designed, it can be applied to one or more statement templates.

Using Statement Designer

Menu: Statements | Statement Setup | Statement Designer
Home: All Actions | Statements | Statement Setup | Statement Designer

The Statement Designer window includes a Layout Tree pane, a Field Selection pane, and a Page
Layout pane.

@ Statement Designer EI@
aaEga/ OO0 | | Toolbar

Georgia vlio ~| B|7|u allr @llr Attribute Bar

b Statement Designer Layouts [0 2 e E A e B | A
=By Sample Layouts ———————— Layout Group

Firm Information

Staternent Customization
Letterhead
Letterhead with Columns

Loge h Fieldsﬂ

@firmName

@firmAddress

Legoe Right
Attorney List ——— _
Draft Statement N
CC Payment Remittance

\@atte @attentionLine
Page N @nameAndAddress St
Layouts | |/;

Invoice

Two Offices
Page 2 - Invoice
Page 2 - Simple ————— B @R DESC
Page 2 - Detail ———————— e | Begin Statement Body |
Cover Statement -

EREDDEBDEDEDD DB D

i B Remittance Page —————— _ Text Box
i-=1 Envelope ———— -

+-=1 Envelope - Statement Enclosed - N

Layout Tree pane

E
E
E
£
E
E
£
E
E
£
E
E
£
E
£
E
£

_ Page Layout pane

b Statement Designer Fields
-3 Firm Fields y
7] System Fields N
£ Statement Customization Fields
£ Bill To Fields
-3 Client Fields

Field Selection pane ;

Figure 31, Statement Designer
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Layout Tree pane

Field Selection pane

Page Layout pane

In the Layout Tree pane, you can manage the layout
groups and page layouts. Each layout group consists of
one or more page layouts. Clicking the plus (+) symbol
next to the name of layout group (e.g., "New Layout
Group”) expands the layout group to display the page
layouts contained therein. Likewise, clicking the minus (-)
symbol next to the name of an expanded layout group will
collapse that layout group, hiding its contents from view.
In the Layout Tree pane of the Statement Designer, you
can add, rename, delete, import and export layout groups,
as well as add, rename, or delete individual page layouts.

The Field Selection pane is used to select and add fields
from the Tabs3 Billing and System Configuration data files
to the current page layout. Clicking the plus (+) symbol
next to a branch in the Field Selection pane (e.g., “Firm
Fields") expands that branch to show the fields contained
therein. Likewise, clicking the minus (-) symbol next to an
expanded branch collapses that branch, hiding its
contents from view. To insert a field into the current page
layout, double-click the desired field, or right-click it and
select the Insert option.

The Page Layout pane is where you control the
appearance of the current page layout. You can add,
remove, or modify various elements such as text boxes,
lines, rectangles, etc., and also control the page layout
properties.

Tabs3 Billing includes a small library of statement layouts with designed letterheads, draft statement
forms, a credit card remittance form, and envelopes that you can modify to use your firm’'s
information, thus allowing you to quickly get started with the Statement Designer.

Complete details regarding the Statement Designer can be found in Help.

More Info: Additional information on using Statement Designer can be found in Tabs3 Billing
Help, in Knowledge Base Article R10923, “Frequently Asked Questions About Statement
Designer,” and in Knowledge Base Article R10901, “Customizing the Sample Page Layouts
Provided with the Tabs3 Billing Statement Designer.” Additionally, there is an excellent
introductory video that shows the various features available in the Statement Designer. Training
Videos can be accessed at Tabs3.com/videos.
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Enabling Statement Designer Page Layouts

Once Statement Designer Layouts have been created or edited as desired, they must be selected in a
client’s Statement Template and enabled in Print Setup in order to be used on a statement.

Statement Templates

The client’s assigned statement template must have the desired Statement Designer Layout selected.

» To specify a layout for a Statement Template

1.

> won

From the Statements menu, select Statement Setup, and then click Statement Templates.

On the General tab, select the Template ID.
On the Layouts tab, in the Page Layouts section, select an existing layout for Page 1.

Optionally select an existing layout for Page 2, Envelope, and Cover.

Click % to save the template.

E Statement Templates EI@

General Fee Format Cost/Payment Format Layouts

Template D: v standard fee & cost format (no recap)

Page Layouts

Page 1: | Sample Layouts | Firm Information v|
Page 2: | Sample Layouts | Page 2 - Detail v|
Envelope: | V|
Cover: | Sample Layouts | Remittance Page v|

Mote: In order to utilize layouts created in the Statement Designer, the Statement
Printer Setup window must have the "Enable Statement Designer Layouts" check box
selected.

I e S Py PSS - PSRRI

Figure 32, Statement Setup - Enable Statement Designer Layouts check box

Note: Changes to a statement template’s settings will apply to every client with the template
selected.

More Info: Additional information on statement templates can be found on page 8 of this guide
and in Tabs3 Billing Help.

Print Setup

Statement Designer page layouts must be enabled for use in the Print Setup.
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» To enable Statement Designer layouts in Print Setup

1. From the File menu, click Print Setup.

Select the Printer to which you print statements.

Click the Statement Setup button.

Select the Enable Statement Designer Layouts check box.

Click OK on the Statement Setup window.

S O

Click OK on the Print Setup window.

Statemnent Setup for Brother HL-2270DW >

MNormal Font: 10 pt Segoe Ul Select [Iprint Envelopes

Statement Width .
Enable Statement Designer Layouts
® Automatic: Percent Adjustment

O Fixed: 0 Columns

B e P e S U S

Figure 33, Statement Setup - Enable Statement Designer Layouts check box

More Info: Additional information on enabling Statement Designer Page Layouts can be found in
Tabs3 Billing Help and in Knowledge Base Article R10944, “Printing Statements with Statement
Designer Page Layouts.”

Training Videos

You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

u Customizing Statements Video (Statement Designer Segment)

Bitmaps and Image Files

Certain image files can be included on your billing statements for a letterhead, or to enhance the
heading. Bitmap files (*.bmp) can be added via Print Setup if you do not want to set up a Statement
Designer Layout, or you can include *.bmp, *.jpg, and *.png files in your Statement Designer Layout.

Enabling Bitmaps or Image Files

Use one of the following methods to add bitmaps or other images on your statement.
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» To add a bitmap via Print Setup

1. From the File menu, click Print Setup.

Select the printer to which you will be printing statements.
Click the Statement Setup button.

In the Page One section, select the Bitmap check box.
Optionally enter a Bitmap Vertical Placement.

Select a Bitmap Alignment.

Click OK on the Statement Setup window.

©® N o vk~ W DN

Click OK on the Printer Setup window.

Page One

Heading Font: 10 pt Arial Select

Paper: Letter e Source: Auto Select v

Blank Lines at Page Top: |0 Blank Lines Before Detail: | 2 [J Compress Address

[ Bitmap Select... Ci\Tabs3\FirmLetterhead.png
Bitmap Vertical Placement: Bitmap Alignment: | Center on Page ~
s st o et e eSS e I Bl B e

Figure 34, Printer Setup

» To add a bitmap or other image file via Statement Designer

1. From the Statements menu, select Statement Setup, and then click Statement Designer.

2. Select the Layout to which you want to add an image.

Click the toolbar button.
Select the image file you want to have printed on statements.

Click the Open button.

o v~ w

Move the image to the desired placement.

7. Click B to save the Statement Designer layout.

Tip: Software Technology offers a letterhead scanning service for a nominal fee. You can send us
the letterhead you want scanned, and we will produce a bitmap file that can be used to print your
firm's letterhead on Tabs3 Billing statements. For more information on our scanning service, visit
Knowledge Base article R10168, “Bitmap Scanning Service.”
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Trust Accounts

When a Tabs3 Billing client is set up for Trust Integration, customized terminology can be used for
trust account balances and activity on the billing statement.

Trust Account Integration and Terminology

Use the following to customize how trust accounts are shown on statements.

» To display trust information on statements

1. From the File menu, select Open, and then click Client.

2. Select the client for which you want trust information displayed on statements.
3. Click the Statement Options tab.
4

In the Statement Format section, in the Trust Integration field, select Detail or Summary.

5. Click B to save the changes to the client.

Figure 35 is an example of how trust activity appears on the statement when the Detail option is
selected:

Trust Account Activity

Opening Balance $52,000.00
10/04/19 Expense money for Dawson

PAYEE: Charles L. Dawson -1,200.00
10/10/19 Sale of Stock 4,255.75
10/11/19 Attorney fees

PAYEE: Jensen & Burns, P.C. -443.75
10/17/19 Real Estate taxes

PAYEE: Lancaster Country Treasurer -1,450.00

Closing Balance $53,162.00

Figure 35, Example of Detail trust activity on a statement

Figure 36 is an example of how trust activity appears on the statement when the Summary option is
selected:

| Your retainer balance is $53,162.00 |

Figure 36, Example of Summary trust activity on a statement
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» To customize terminology for trust accounts

1. From the Trust Accounting Software File menu, select Open, and then click Miscellaneous.
Click the Bank Account tab.
Select a Bank Account.

Click the Integration Settings button.

AR A

In the Tabs3 Statement/WIP Terminology section, enter the desired balance and remittance
text.

6. Click ﬁ to save the changes to the bank account.

Tabs3 Integration Settings ? X

Tabs3 Statement/WIP Terminclogy

Current Balance: |Y0ur retainer balance is

Opening Balance: |Opening retainer balance

Closing Balance: |Closing retainer balance

Bill Remittance: |As per our agreement please remit:

Target Remittance: |Tn meet your minimum retainer balance, please remit:

whmahc TeateagtimaC aros cDoumants. s et o st gttt

Figure 37, TAS - Tabs3 Statement/WIP Terminology

Training Videos

You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

u Tabs3 Trust Accounting Integration Video
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Conclusion

Resources

Tabs3 Billing statement customization features provide the tools to give your statements the look
you want. Additional information on the features discussed in this guide can be found in the Tabs3
Billing Help. Simply press F1 from anywhere within the software to load the Help information for that
particular topic.

Guides and Sample Statements
Additional guides and resources for other software features are also available, including the
following:

« Statements Guide - This guide provides an overview of the process of generating monthly
billing statements.

« Tabs3 Billing Sample Reports - Over 20 pages of sample statements, and the formatting
options that were used to create the statements, can be found in the Tabs3 Billing Sample
Reports.

All guides and sample report packs are available on our Web site at:

Tabs3.com/support/docs.html

Knowledge Base
Our Knowledge Base can be accessed 24 hours a day, 7 days a week. You can also access our
Knowledge Base while in the software by selecting Help | Internet Resources | Knowledge Base.

« R11582 - “Statements Information Resources,” is a comprehensive list of Knowledge
Base Articles containing more information about Tabs3 Billing statements.

All Knowledge Base Articles are available on our Web site at:

support.Tabs3.com
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Training Videos

You can view the following training videos for more information. Clicking a link will open the
associated training video in your browser. All training videos are also accessible in the software via
the Help | Training Videos menu and at Tabs3.com/t3video.

u Customizing Statements Video

u Emailing Statements Video

n Client Overview Video

n Trust Accounting Integration Video
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